Session 2: Introduction to R Programming
R for Data Analysis

DIME Analytics
The World Bank |

April 2025



https://github.com/worldbank

Table of contents

1
2
3
4
5
6
7/
8

. Introduction

. Initial settings

. File paths

. Using Packages

. Functions inception

. Mapping and iterations
. Custom functions

. Appendix

2 /90



Introduction




What this session Is about

In the first session, you learned how to work with R. You are probably eager to start programming in R by now

But before you start, we recommend learning how to write R code that will be reproducible, efficient, intelligible and
easy to navigate

Today, we will cover common coding practices in R so that you can make the most efficient use for it
We will also discuss some styling conventions to make your code readable and clear

This will give you a solid foundation to write code in R and hopefully you'll be able to skip some painful steps of the
"getting-your-hands-dirty" learning approach
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Initial settings




Initial settings

e |et's start by opening RStudio or by closing and opening it again
e Notice two things:

1. Your environment is probably empty (it's okay if it's not)

Environment History Connections Tutorial p—
— ; \ F i
% Il | = Import Dataset ~ | &) 66 MiB ~ | & List = | (&~

R ~ "} Global Environment ~

Environment is empty
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Initial settings

e |et's start by opening RStudio or by closing and opening it again
e Notice two things:

1. Your environment is probably empty (it's OK if it's not)
2. Go to the Console panel and use the up and down keys to navigate through previously executed commands. They are
saved by default in a file named .Rhistory that you might have noticed

£

Name Date modified Type
DataWork 10/27/2022 10:36 AM File folder
learnr 7/19/2022 4:47 PM File folder
Presentations 3/19/2023 12:11 PM File folder

ﬂ .gitignore 7/19/2022 4:47 PM GITIGNORE File

D .Rhistory 5/26/2022 1:27 PM RHISTORY File

R dime-r-training.Rproj 5/26/2022 9:10 AM R Project

D LICENSE 12/15/2020 2:53 PM File

& README.md 3/14/2023 4:24 PM MD File
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Initial settings

e |et's start by opening RStudio or by closing and opening it again
e Notice two things:

1. Your environment is probably empty (it's OK if it's not)
2. Go to the Console panel and use the up and down keys to navigate through previously executed commands. They are

saved by default in a file named .Rhistory that you might have noticed

e We usually want these two things —an empty environment and the history of commands executed in previous sessions—
to be present every time we open a new RStudio session
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Initial settings

Have you ever seen these lines of code before?

E Do-file Editor - MyStataDoFile.do
File Edit View Project Tools

NEES & x @A s FF

MyStataDoFiledo X

|4=
fal

clear

set memory 200m
set maxvar 120000
set more off

set wvarabbrev off

[ I Iy IO R 6 T ]
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Initial settings

Have you ever seen these lines of code before?

E Do-file Editor - MyStataDoFile.do
File Edit View Project Tools

NEEdS® &4 L DA e FF

MyStataDoFile.do X

fal

clear

set memory 200m
set maxvar 120000
set more off

set wvarabbrev off

[ I Iy IO R 6 T ]

« We don't need to set the memory or the maximum number of variables in R
e The equivalent of set more off Isthe default

e The equivalent of clear inRis m(list = 1s()), which removes all the objects in the environment. It is not always
default setting, but we'll make sure it is set in exercise 1
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Initial settings

Exercise 1E) (1 min)

After this, you'll never have to use the equivalent of clear all
1. Go to Tools > Global Options...
2. In the General tab, make sure the following options are set:

o Un-check Restore .RData into workspace at startup
o For Save workspace to .RData on exit, select Never
o Make sure Always save history (even when not saving .RData) is checked

3. Now restart RStudio
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Initial settings

) dime-r-training - RStudio
File  Edit  Code
Ql-leplar-

View Build  Debug  Profile

=Y

Render

Plots  Session

# Go to file/function gl + Ac

Console  Terminal Background Jobs

R

R version 4.2.1 (2022-06-23 ucrt) -- "Funny-Looking Kid"
Copyright (C) 2022 The R Foundation for Statistical Computing
Platform: x86_64-w64-mingw32/x64 (64-bit)

R4.21 - C/WBG/Repos/dime-r-training/

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type "license()' or 'licence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-Tine help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

>

Tools  Help

Install Packages...

Check for Package Updates...

Version Control

Shell...

Terminal
Background Jobs
Addins

Memory

Keyboard Shortcuts Help

Modify Keyboard Shortcuts...

Edit Code Snippets...

Show Command Palette
Project Options...

Global Options...

Alt+Shift+K

Ctrl+Shift+P

$ dime-r-training =

Environment History Connections Tutorial =[]
2 [ T Import Dataset ~ 196 MiB ~ | & List - | @& -
R~ 1 Global Environment =
Environment is empty
Files Plots Packages Help Viewer Presentation = ]
© ) Folder  © BlankFile ~ | @ Delete | 4] Rename {* -
| C > WBG > Repos > dime-r-training J}l
A Name Size Modified

t.

) .gitignore 1.7 KB Apr 24, 2023, 3:41 PM

7 Rhistory 0B May 7, 2023, 10:46 PM

(] Datawork

B dime-r-training.Rproj 218 B Feb 24, 2024, 8:17 PM

(] learnr

| LICENSE 1.1 KB Apr 24, 2023, 3:41 PM

(| Presentations

] Presentations-GeorgiaRS

ve| README.md 4.8 KB Feb 24, 2024, 8:15 PM

vo| setup-and-troubleshooting.md 2.8 KB Apr 24, 2023, 3.41 PM
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Initial settings

Options
General Graphics Advanced
Code R Sessions
R version:
> Console

| [Default] [64-bit] C:\Program Files\R\R-4.2.1 Change...

-ﬂ AppeRmnce Default working directory (when not in a project):

- rowse...
Pane Layout | Browse

Packages Restore most recently opened project at startup

+| Restore previously open source documents at startup

;
@ R Markdown
F

Workspace
Python Restore .RData into workspace at startup

Save workspace to .RData on exit: | Never ¥
@ sweave P

History

Y Spelling
- /] Always save history (even when not saving .RData)
. Git/SVN Remove duplicate entries in history
_ Oth
"E} Publishing e
Wrap around when navigating to previous/next tab

Bl rerminal /] Automatically notify me of updates to RStudio
o Accessibility +1 Send automated crash reports to RStudio
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File paths




File paths

e What about working directories? We usually do something like this every time we start a new script in Stata:

Ell Do-file Editor - Untitled*
File Edit View Language Project Tools

DeHBE Q ¥k 9 EUNRL B,

cd "path/that/only/exists/in/my/computer"

vi B w R

e The command to print the current working directory in R is:

getwd()
e And the direct equivalent to cd in R is this command:
setwd("your/path")

» However, we recommend not using it unless it's absolutely necessary (never, if possible)
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RStudio projects

Instead, you should use RStudio projects and the here library

RStudio projects let you "bind" your project files to a root directory, regardless of the path to it

This is crucial because it allows smooth interoperability between different computers where the exact path to the project

root directory differs

Additionally, each RStudio project you work on keeps their own history of commands!

Important: We won't get into the specifics of directory organization here, but we'll assume that all the files you use for a
specific project (data, scripts, and outputs) reside in the same project directory. We'll call this the working directory.
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RStudio projects

Exercise 2 B (® 3 min)

1. Create a folder named dime-r-training in your preferred location in your computer

2. Go to https://osfio/382kv and download the file DatalWork.zip (click on the vertical ellipsis next to the file
name)

3. Unzip DataWork.zip in your folder dime-r-training-202403
4. On RStudio, select File > New Project... (the window will load for a few seconds)
5. Select Existing Directory

6. Browse to the location of dime-r-training and select Create Project

17 / 90


https://osf.io/382kv

RStudio projects

R dime-r-training ~

Environment History Connections Git Tutorial ]

<2 & | * Import Dataset ~ 152 MiB - { List ~ | (&~
R~ 1 Global Environment =

Environment is empty
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RStudio projects

Files Plots Packages Help Viewer Presentation -]
@ NewFolder ' © NewBlankFile ~ @ Delete = |Rename {3’ More ~ S
| 48 Home > dime-r-training R
A Name Size Modified
1
(] R dime-r-training.Rproj 218 B Mar 23, 2025, 10:52 AM
| ] Datawork

19 / 90



Now that we're working in a project, we can use the library here to define any file paths relative to the project folder.

e here locates files relative to your project root
e |t uses the root project directory to build paths to files easily

It allows for interoperability between different computers where the absolute path to the same file is not the same
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e Load here

install.packages("here") # install first if you don't have it
library(here)

e Now you'll be able to use here() to pointthe location of every file relative to your project root

o For example, to load a csv file located in: C:/WBG/project-root/data/raw/data-file.csv, you should use:

path <- here("data", "raw", "data-file.csv")

df <- read.csv(path)

* Notes:

o Your project root is the directory that contains the .Rproj file
o The result of here() is an absolute path that points to a file or folder location in your computer
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File paths

Exercise 3 B (3 min)

1. Goto File > New File > R Script to open a new script
2. In the new script, load here and read the .csv file in DataWork/DataSets/Final/whr_panel.csv using here()

o Use the function read.csv() to load the file. The argument for read.csv() is the result of here()
o Remember to assign the dataframe you're reading to an object with <-. You can call it whr as we did
yesterday

o If you get an error saying could not find function "here", then load the library first with library(here)

whr <- read.csv(here("DatalWork", "DataSets", "Final", "whr_panel.csv"))
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RStudio projects and |8

If you did the exercise correctly, you should see the whr dataframe listed in the Environment panel

Environment History Connections  Tutorial [
€2 k= | 72 import Dataset - | & st ~ | @ -
1 Global Environment -

Data
O whr 470 obs. of 8 variables
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Using packages




Packages

e Installing R in your computer gives you access to its basic functions

o Additionally, you can also install packages. Packages are code with additional R functions that allow you to do:
o Operations that basic R functions don't do (example: work with geographic data)
o Operations that basic R functions do, but easier (example: data wrangling)

e Packages are also called libraries or dependencies
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Packages

In a nutshell:

2
@ + e =

N y N AN J
e NG NG

Basic R Libraries Enhanced R capabilities
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Packages

e You can install packages with the command 1install.packages().

# Installing a package
install.packages("dplyr")

e You only have to install a package once, but you have to load them every new session with library()

# Installing a package
library(dplyr)
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Packages

e Package installation: only once in your computer

e Package loading: in every new RStudio session
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Using packages

Exercise 4 B (®© 1 min)

1. Load the packages dplyr and purrr using library(dplyr) and library(purrr)

Note: There is probably no need to install dplyr and purrr as they are part of the meta-library tidyverse, which we asked to
install before this course. If you didn't have the chance to install tidyverse, then first install dplyr and purrr with:

install.packages("dplyr")
install.packages("purrr")

And then just load them:

library(dplyr)
library(purrr)

Important: installing requires the user to refer to the package name as a string using quotes. Loading the package doesn't use
quotes for the package name.
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Warnings vs errors

What if this happens?
> Tibrary(dplyr)
Attaching package: ‘dplyr’
The following objects are masked from ‘package:stats’:
filter, Tag
The following objects are masked from ‘package:base’:
intersect, setdiff, setequal, union

warning message:
package ‘dplyr’ was built under R version 4.2.2
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Warnings vs errors

R has two types of error messages, warnings and actual errors:

e Errors - break your code, usually preventing it from running
« Warnings - your code kept running, but R wants you to be aware of something that might be a problem later

RStudio prints warning messages but it doesn't stop the code excution if warnings occur.
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Functions inception




A function inside a function

e In R, you can write one function inside another

e Here's an example:

33 /90



A function inside a function

# Print the summary of the logarithm of the happiness score

## The long way:
log _score <- log(whr$happiness_score)
summary(log_score)

# The shortcut
summary(log(whr$happiness_score))

Code & StartOver P Run Code

34 /90




A function inside a function

 This is a simple example of metaprogramming (that's the real name of this technique) and may seem trivial, but it's not

e For starters, you can't do it in Stata!
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A function inside a function

- (R)
/ Lo
[ Fi i/ Fi A 15.1 Copyright 1985-2017 StataCorp LLC
Statistics/Data Analysis StataCorp
4905 Lakeway Drive
MP - Parallel Edition College Station, Texas 77845 USA
800-5TATA-PC nttp://WwWW.stata.com
G979-696-4600 stata@stata.com

979-65%6-4601 (fax)

68l-user 4-core S5tata network perpetual license:
Serial number: 501506002486
Licensed to: WBG User
World Bank Group

Hotes:

Unicode is supported; see help unicode advice.

More than 2 billion observations are allowed; see help obs_ advice.
Maximum number of variakbles is set to 1200007 sees help Set mMaXVar.

[ o A

Hew update awvailable; type —-update all-
running C:%\Program Files (x86)\StatalS\sysprofile.do

sysuse anto
(1578 Automobile Data)

summarize log(make)

variakle log not found
r(lll):

36 /90



A function inside a function

e Metaprogramming is a very powerful technique, as you will soon see

 |t's also a common source of error, as you can only use one function inside the other if the output of the inner function
can be taken as the input of the outer function

e |t can also get quite tricky to follow what a line of code with multiple functions inceptions is doing
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Ever heard of piping? It's this: %>%

Piping is a way of doing metaprogramming

The actual meaning of the pipes is: Pipes take the output of the function at the left and pass it as the first argument of
the function at the right

The advantages of using piping is that it allows to have a cleaner division of successively applied functions in R code,
drastically improving code readability
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# 1: Doing it the long way ----------=-=-------————-------
log _score <- log(whr$happiness_score)

mean(log_score)

# 2: Shortcut to get to the same place -----------------
mean(log(whr$happiness_score))

# 3: Now with pipes ---------------=--"-"-----"—"--~—-~—~—"——~—~—\—-
whr$happiness _score %>% log() %>% mean()

In other words:
e x %% f() Isthe same as f(x)

e x %% f() %% g() isthesameas g(f(x))
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Always use pipes!

Now that you now about the power of the pipes, use them wisely!

Remember that pipes are part of the library dplyr,
you need to load it before using them

Pipes also avoid the hassle of having to save
Intermediate results in new objects in the
environment, improving efficiency

Many R coders use pipes and internet examples
assume you know them

We'll use pipes from now on for some of the next
examples and exercises of the rest of this training
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Mapping and iterations




Iterations in R

e In Stata, we use for loops very frequently

e In R, the syntax of for loops is this:

for (number in 1:3) {
print(number)

}

## [1] 1
# [1] 2
## [1] 3
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Map

e R, however, has a set of functions that allows users to loop through an object in a more efficient way, without using
explicit loops

e In this training we'll introduce map() . It is a function part of purrr, a package that contains tools for functional
programming

« Also, in case you have not noticed yet: R is vectorized! this means that many operations are applied element-wise by
default so you don't have to code loops to apply them to each element of a vector or dataframe
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Map

e To use map(), you need to load the package purrr

e The basic syntax of map() is:

map(X, function, ...):applies function to each of the elements of X.If X is a dataframe then function is

applied column-wise while if it's a vector or a list it is applied item-wise. The output of map() Is always a list with the
results.

e X: a dataframe, matrix or vector the function will be applied to
 function: the name of the function you want to apply to each of the elements of X
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Map

# Round the values of the following vector
x <- c(1.2, 2.5, 9.1, 5.8)
map(x, round)) # Rounding the vector elements, same as x %>% map(round)

round(x) # since R is vectorized, this also works

Code & Start Over P Run Code
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Map vs looping

» When looping, you repeat the same operation over a set of items
e map(), instead, takes all your elements at once and applies an operation to them simultaneously
e The difference is like this:

o Imagine you ask a yes/no question to a group of people
o You can collect the answers by asking each one of them individually -- this is looping
o Otherwise, you can ask them to raise their hands and collect all answers at once -- this is map()
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Map vs looping

e The output of a loop Is the regular output of the operation you're repeating, times the number of iterations you did
e The output of map() will be always a list
e When it comes to code clarity, map() has a few advantages:

o Loops often have side effect results, like a temporary variable that stays in the environment after the loop finishes
o map() often involves less lines of code than loops
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Map vs looping

Exercise 5: Looping over a dataframe (® 3 min)

e Create a toy dataframe of 50,000 columns and 400 observations using this code

df <- data.frame(replicate(560000, sample(1:100, 400, replace=TRUE)))

e Create an empty vector named col_means_loop wWhere you will store column means with this code:
col_means_loop <- c()
e Loop over every column to get the column means and store them in the vector

for (column in df) {

e Inside the loop:

o Use mean() to get each column mean

o Use append() to add a new mean to the vector: col_means_loop <- append(col_means_loop, new_mean)
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Map vs looping

The solution is this:

df <- data.frame(replicate(50000, sample(1:100, 400, replace=TRUE)))
col_means_loop <- c()
for (column in df){

new_mean <- mean(column)

col_means_loop <- append(col_means_loop, new_mean)
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Map vs looping

Exercise 6: Now use map() E (® 1min)

1. Use map() to produce a list with the means of the columns of df
2. Store the result in a list named col_means_map
Hints:

e Remember the syntax of map(): map(X, function_name)
e The function name inside map() shouldn't have parentheses next to it (i.e: mean instead of mean())

(the exercise solution is shown in the next slide)

50/ 90



Map vs looping

The solution is this:
col_means_map <- map(df, mean)
You can also do it with pipes:

col_means_map <- df %>% map(mean)
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Map vs looping

Compare the syntax of the solutions of both exercises:

# Dataframe creation
df <- data.frame(replicate(56000, sample(1:1006, 400, replace=TRUE)))

# Loop exercise
col_means_loop <- c()

for (col in df){
col_means_loop <- append(col_means_loop, mean(col))

}

# Map exercise
col_means_map <- map(df, mean)

Do you remember which one ran faster?
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Map vs looping

Also, remember we said that loops produce side effects?

Environment History Connections Tutorial

L]

£ I | =2 Import Dataset ~ | &) 921 MiB ~ & List =

R = | "} Global Environment ~

Data

@ col_means_map Large 1ist (50000 elements, 6.4 MB)
O df 400 obs. of 50000 variables

values

col_means_loop num [1:50000] 50.8 51.3 50.8 51 50.5 .

column int [1:400] 18 5 50 43 79 31 13 36 17 ..

53 /90



Map vs looping

e map() looks nice, doesn't it?

e But what about cases when it's impossible to implement the operations | want to apply in only one function? Do | have to
use for loops then?

e Not at all! Let's get to the next section for those cases.
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Custom functions




Writing your own functions

» As we have said several times, R is super flexible
e One example of that is that it's super easy and quick to create custom functions

e Here's how:
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Custom functions

square <- function(x) {

y <- x "2
return(y)
}
Code & Start Over
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Custom functions

Exercise 7 EE) (® 2 min)

Create a function named zscore that standardizes the values of a vector.

Hints:

e The command to obtain the mean of a vector is mean(x)

The command to get the SD of a vector is sd(x)

R is vectorized: you can operate vectors and numbers directly and the result will be a vector
Don't forget to include the argument na.rm = TRUE in mean() and sd()

Recall the syntax of custom functions in R:

function_name <- function(input) {
output <- operation(input)
return(output)

}
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Custom functions

zscore <- function(x) {
mean <- mean(x, na.rm = TRUE)
sd <- sd(x, na.rm = TRUE)

z <- (x - mean)/sd
return(z)
1
Code | &£ StartOver
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Custom functions

Exercise 8

1. Subselect the columns health_life_expectancy and freedom In whr
o Use dplyr's select() for this, as in: whr %>% select(freedom, happiness_score)

2. Use map() combined with the zscore function to get the z-score of these two columns and assign the resulting
list to an object named z_scores

3. Use list indexing on z_scores to generate two new columns in whr with the standardized values of
health_life_expectancy and freedom

Hints:

Don't use parenthesis next to the function name we're using map() with
Use double brackets instead of single brackets or the symbol $ to index the elements of a list

60 / 90



Custom functions

z_scores <- whr %>%
select(health_life _expectancy, freedom) %>%
map(zscore)

whr$hle st <- z_scores[[1]]

whr$freedom st <- z_scores[[2]]

Code & start Over

1
2
3
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Thank you!




Appendix




Appendix - [N and (N

e _.Rhistory automatically stores the commands entered in the console

e _.RData stores the objects in your environment only if you save your workspace, and loads them again in the next RStudio
session

e Both files are stored in the working directory where your RStudio session started
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Appendix - More on packages

Once a package is loaded, you can use its features and functions. Here's a list of some useful packages:

e Rcmdr - easy to use GUI

e swirl - an interactive learning environment for R and statistics.

e ggplot2 - beautiful and versatile graphics (the syntax is a pain, though)

e stargazer - awesome latex regression and summary statistics tables

o foreign - reads .dta and other formats from inferior statistical software

e zoo - time series and panel data manipulation useful functions

e data.table - some functions to deal with huge dataframes

e sp and rgeos - spatial analysis

e multiwayvcov and sandwich - clustered and robust standard errors

e RODBC, RMySQL, RPostgresSQL, RSQOLite - For relational databases and using SQL in R.
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Appendix - Git

Git is a version-control system for tracking changes in code and other text files. It is a great resource to include in your work
flow.

We didn't cover it here because of time constraints, but below are some useful links, and DIME Analytics provides trainings on
Git and GitHub, so keep an eye out for them.

« DIME Analytics git page: https://worldbankgithub.io/dimeanalytics/git/

A Quick Introduction to Version Control with Git and GitHub: https://journals.plos.org/ploscompbiol/article?
1d=101371/journal.pcbi1004668
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Appendix - More on R projects

If you want to learn more about them, we recommend starting here: https://r4ds had.co.nz/workflow-projects.html
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Appendix - More on folder management

e Adiscussion of folder structure and data managament can be found here:
https://dimewiki.worldbank.org/wiki/DataWork_Folder

e For a broader discussion of data management, go to https://dimewikiworldbankorg/wiki/Data_Management
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Appendix - Column extraction operators

e Remember the use of § to extract columns from a dataframe?

e Other than §, we can also use double brackets to extract the column of a dataframe:

# With §:
whréyear

# with [[]]:

whr[["year"]] # Notice the use of double quotes
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Appendix - Column extraction operators: [l vs B

What's the key difference between them?

Well, [[1] lets us use other objects to refer to column names, while § doesn't

col_name <- "year"

head(whr$col _name) # this returns a NULL object because no column has the name "col_name" in whr

## Warning: Unknown or uninitialised column: "col_name .

## NULL

col_name <- "year"
head(whr[[col_name]])

#4# [1] 2015 2815 2015 2815 2815 2015
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Appendix - Column extraction operators: [l vs B

This difference is key because we can use [[]1] to loop through column names, while this is not directly possible with §.

# Printing the first observation of every column of whr

for (col in colnames(whr)) {

whr[[col]]
head(1) %>%

it
it
3
it
it
i
it
3

print()

[1]
[1]
[1]
[1]
[1]
[1]
[1]
[1]

"Switzerland"
"Western Europe"

2015

.587

.39651
.94143
.66557
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Appendix - Apply

Apart from purrr's map(), base R also has a set of functions that allows users to apply a function to a number of objects
without using explicit loops

They're called apply and there are many of them, with different use cases

If you look for the apply help file, you can see all of them

We'll show only two of them, sapply and apply
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Appendix - Apply

e The syntax of sapply() is:
sapply(X, FUN, ...)

e Its main arguments are:

o X:a dataframe, matrix or vector the function will be applied to
o FUN: the function you want to apply

e sapply() applies the function (FUN) to all the elements of X. If X is a dataframe then the function is applied column-
wise, while if it's a vector or a list it is applied item-wise

e The output of sapply() is usually a vector with the results, but it can be a matrix if the results have more than one
dimension
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Appendix - Apply

# A for loop in R
for (number in c(1.2, 2.5)) {
print(round(number))

}

# A much more elegant option
sapply(c(1.2, 2.5), round)
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Appendix - Apply

# Printing the first observation of every column of whr
for (col in names(whr)) {

print(head(whr[[coll], 1))
} # Option 1

sapply(whr, head, 1) # A more elegant and efficient option
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Appendix - Apply

e A more general version of sapply() isthe apply() function. This is its syntax:
apply(X, MARGIN, FUN, ...)

e Arguments:

o X: a dataframe (or matrix) the function will be applied to
o MARGIN: 1 to apply the function to all rows or 2 to apply the function to all columns
o FUN: the function you want to apply

e apply() applies a function (FUN) to all columns or rows of matrix (X ). A value of 1in MARGIN indicates that the funcion
should be applied row-wise, while 2 indicates columns
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Appendix - Apply

matrix <- matrix(c(1, 24, 9, 6, 9, &4, 2, 74, 2), nrow = 3) # Defining a matrix
apply(matrix, 1, mean) # row means
apply(matrix, 2, mean) # column means
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Appendix - Assignment 1

Exercise: Get the row max

1. Select the columns freedom and happiness _score Of whr
2. Use apply() to get the row max between these two columns, for every row

e Hints:
o Remember the syntax of apply(): apply(X, MARGIN, FUN)
o Avalue of 1for MARGIN indicates that the function must applied row-wise
o The function to get the maximum over a set of number is max
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Appendix - Apply

Solution:
whr %>%

select(freedom, happiness_score) %>%
apply(1, max)
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Appendix - Commenting

e To comment a line, write # as its first character

# This 1is a comment

print("But this part is not")
e You can also add # halfway through a line to comment whatever comes after it
print("This part is not a comment") # And this is a comment

e In Stata, you can use /* and */ to comment in the middle of a line's code. That is not possible in R: everything that
comes after # will always be a comment

e To comment a selection of lines, press Ctrl + Shift + C
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Appendix - Assignment 2

Exercise

1. In your script panel, select all the lines of your script
2. Use the keyboard shortcut to comment these lines.
o Shortcut: Ctrl + Shift + C

3. Use the keyboard shortcut to comment these lines again. What happened?
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Appendix - Document outline

e RStudio allows you to create an interactive index for your scripts

» To add a section to your code, create a commented line with the title of your section and add at least 4 trailing dashes ( -
---), pound signs ( #### ) or equal signs (====) after it
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Appendix - Document outline

e The outline can be accessed by clicking on the button on the top right corner of the script window. You can use it to jump

from one section to another

e You can also use the keyboard shortcuts Alt + L (Cmd + Option + L on Mac)and Alt + Shift + L to collapse and

expand sections

@] exercises.R ]
b Source on Save | O ,/I-"' SRun | ®%| [ Psource ~| =

1~ # Part 1: Loading libraries---- Part 1: Loading I...
2 Tibraryc(here) | Part 2: Loading ...
3
4~ # Part 2: Loading data----
5 whr <- read.csv(Chere("Datawork"”, "DataSets", "Final", "whr_panel.csv"))
6 |

6:1 E3 Part 2: Loading data < R Script

83 /90



Appendix - Indentation

# Here's some code
annualHappy_reg <- aggregate(happy_score -~ year + region, data = whr, FUN = mean)
ggplot(annualHappy _reg,aes(y = happy_score,x = as.factor(year), color = region, group = region)) +

geom_line() + geom_point()

# Here's the same code
annualHappy_reg <-
aggregate(happiness _score ~ year + region,
data = whr,
FUN = mean)

ggplot(annualHappy_reg,
aes(y = happiness_score,
x = as.factor(year),
color = region,
group = region)) +
geom_line() +
geom_point()
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Appendix - Indentation

happiness_score

()]
1

(G}
1

2016
as.factor(year)

2017

region

Australia and New Zealand
Central and Eastern Europe
Eastern Asia

Latin America and Caribbean
Middle East and Northern Africa
North America

Southeastern Asia

Southern Asia

Sub-Saharan Africa

SO SO O O O OO O O

Western Europe
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Appendix - Indentation

e R understands what unindented code says, but it can be quite difficult for a human being to read it

e On the other hand, white space does not have a special meaning for R, so it will understand code that is more readable
for a human being
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Appendix - Indentation

e |Indentation in R looks different than in Stata:

o To indent a whole line, you can select that line and press Tab
o To unindent a whole line, you can select that line and press Shift + Tab
o However, this will not always work for different parts of a code in the same line

e In R, we typically don't introduce white space manually

e It's rather introduced by RStudio for us
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Appendix - Assignment 3

Exercise

To see an example of how indenting works in RStudio, let's use an example with map() :

# An elegant "loop" in R
map(c(1.2, 2.5, 9.1, 5.8), round)

1. Add a line between the two arguments of the function (the vector of numbers and round)

2. Now add a line between the numbers in the vector.
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Appendix - Indentation

Note that RStudio formats the different arguments of the function differently:

# A much more elegant loop in R
map(c(1.2,
2.5,
9.1,
5.8),
round)
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Appendix - Exploring a dataframe

Some useful functions:

e View():opens avisualization of the dataframe

class() : reports object type or type of data stored

dim() : reports the size of each one of an object's dimension

names () : returns the variable names of a dataframe

str(): general information about the structure of an R object
summary() : summary information about the variables in a dataframe
head() : shows the first few observations in the dataframe

tail() : shows the last few observations in the dataframe
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